
SCHOOL OF ARCHITECTURE
OKLAHOMA STATE UNIVERSITY

STUDENT GUIDE



The vision of the School of Architecture is to empower students to make 
creative contributions in the cause of architecture.

The mission of the School of Architecture is to cultivate a collaborative 
learning community focused upon critical thinking and ethical responsibility. We 
embrace established fundamentals and encourage the exploration of emerging 
innovations in design and technology.
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WELCOME

Hello students of the School of Architecture!

Ours is a very special community; you may be new to the school and 
our studio culture, or you may already be familiar with the quality 
of student life here. Welcome, as we start a new semester! Each 
semester is a new beginning – a time when you can decide to commit 
your time and effort, and truly explore the ideas and opportunities 
offered to you. Your faculty and I are dedicated to working with you, 
to propel your education to the next level. You only get to spend five 
years or so with us – together let’s make those years count!

In this manual you will learn about the many opportunities and 
resources available to you within the School of Architecture. Keep in 
mind that our college, CEAT, and the university offer many more ways 
to engage or receive assistance - as the case may be. I encourage you 
to focus your experience as a student at OSU on learning, doing, and 
becoming your best self. 

Good luck, and Go Pokes!

Suzanne Bilbeisi, AIA
Centennial Professor of Architecture
Head of the School of Architecture
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Email: architecture@okstate.edu
Website: https://arch-ceat.okstate.edu
Facebook: Oklahoma State University School of Architecture
Instagram: @OkStateArch
Twitter: @OkStateArch

◄  Edmon Low Library



OUR SCHOOL
The School of Architecture has 
enjoyed a 110-year history as an 
important unit within Oklahoma State 
University, a significant land-grant 
academic and research institution. 
Today, the School is proud of its 
innovative faculty, supportive staff, 
hard-working and talented students, 
and state of the art facility. The 
School is known as a professional 
program offering undergraduate 
degrees in architecture and 
architectural engineering. The 
relationship of the School to the 
College of Engineering, Architecture, 
and Technology is unique and 
supports the strong and symbiotic 
relationship between the 19 faculty 
and 325 students in architecture and 
architectural engineering. The strong 
relationship between programs is 
key to the success of OSU School 
of Architecture graduates, who 
enjoy great success in the practice 
of architecture and architectural 
engineering in Oklahoma, the United 
States, and the world. 

School of Architecture faculty:

Suzanne Bilbeisi, AIA
suzanne.bilbeisi@okstate.edu

Moh’d Bilbeisi, RA
mohd.bilbeisi@okstate.edu

Jeanne Homer, AIA
jeanne.homer@okstate.edu

Jared Mcken, Dr Sc Arch
jared.macken@okstate.edu

Khaled Mansy, PhD
khaled.mansy@okstate.edu

Christina McCoy, PE, RA
christina.mccoy@okstate.edu

Keith Peiffer, AIA
keith.peiffer@okstate.edu

John Phillips, PE
john.j.phillips@okstate.edu

Sarah Ra, AIA, NCIDQ
sarah.ra@okstate.edu

Seung Ra, AIA
seung.ra@okstate.edu

6



Michael Rabens, PhD
michael.rabens@okstate.edu

Carisa Ramming, PE
carisa.ramming@okstate.edu

Nathan Richardson, AIA
nathan.richardson@okstate.edu

Awilda Rodriguez-Carrion, RA
awilda@okstate.edu

Paolo Sanza, RA
paolo.sanza@okstate.edu

Randy Seitsinger, FAIA
randy.seitsinger@okstate.edu

Tom Spector, PhD, AIA
tom.spector@okstate.edu

Jerry Stivers, RA
jerry.stivers@okstate.edu

Jay Yowell, AIA
yowell@okstate.edu
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▼  2019 Grand opening of the ARCH Centre



Architecture Degree 

Architecture is the complex synthesis 
of creatively solving problems 
involving both art and science through 
the disciplined orchestration of 
image-making, activity organization, 
technological applications, legal 
constraints and budgetary parameters 
which together express culture, 
enhance quality of life and contribute 
to the environment. The Bachelor 
of Architecture degree at OSU is 
accredited by NAAB. The design 
studio is the center of the educational 
program in architecture. It is the 
setting where students and faculty 
work closely together, and where all 
specialized study and knowledge 

comes together as a synthesized 
study in design. Education in 
architecture consists of classroom 
and studio courses, conducted in an 
intellectual climate which stimulates 
inquiry, introduces principles and 
values, and teaches the disciplines 
necessary to work in collaboration 
with others. The goal of the program 
is to educate future leaders within the 
architecture profession. Graduates 
who hold this degree typically enter 
the profession of architecture, but 
the broad problem-solving education 
that is central to the degree allows a 
graduate to pursue tangent careers 
as well. 

OUR PROGRAMS
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▲  Professor Bilbeisi teaching first-year students



Architectural Engineering Degree

The study of architectural engineering 
(AE) is an integrated mix of liberal 
studies, design, and technical 
education. Architectural engineers 
need to be able to conceptualize 
aesthetic issues and design complex 
technical systems. The School of 
Architecture offers two paths within 
Architectural Engineering: Building 
Structures and Construction Project 
Management. Both degree options 
are accredited by ABET, and are 
concerned with the technical 

aspects of bringing an architectural 
concept to reality. Graduates in the 
Building Structures path will concern 
themselves with the design of all 
of the components that comprise a 
structural system for a building, from 
the foundation to the roof structure. 
Graduates in the Construction Project 
Management path will be involved in 
the design and management of the 
construction process of a building. 
Students in AE choose their path upon 
entry into Professional School.
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▲  Professor Phillips in comprehensive design studio
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Professional School

Our degrees are professional degrees 
designed to lead to professional 
licensure, not general Bachelor of 
Arts or Science degrees. Based 
upon the successful performance in 
the first two years of coursework, 
students are admitted into the 
Professional Schools of Architecture 
or Architectural Engineering. In 
Professional School, students pursue 
more advanced areas of problem-
solving in architectural or engineering 
design.

Professional School Admission

Students apply to Professional School 
at the completion of their second year. 
Admission is granted based upon 
several factors, the most important 
of which is by meeting the minimum 
Selection GPA of 2.8 – based on 
ten courses, several of which are 
weighted in the calculation. For 
more information on the Professional 
School admissions process, students 
can find the policy on the school’s 
website or ask the academic advisor 
for a copy.

▲  Students working together in the studio



Graduate Certificate in Integrative Design

This 12-credit certificate provides advanced students with additional 
training and education in a specialty area related to the technical aspects 
of architecture or engineering design. The certificate culminates in an 
independent study course, to be supervised by two faculty members, in which 
the student will apply the concepts learned in coursework to the process of 
solving a unique design challenge fundamental to the technical area under 
study. The Graduate Certificate is administered by the OSU Graduate College, 
however students are academically advised in the School of Architecture. For 
more information, ask our academic advisor.

Minors Offered:

The School offers two minors: 
History/Theory of Architecture 
(ASHT), and Architecture & 
Entrepreneurship (ASAE). Each 
is 21 credit hours with some 
overlap of required courses for 
the major. With careful planning, 
a minor can be achieved at no 
extra cost. Ask our academic 
advisor for more details.
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▲  Professor Spector in comprehensive design studio



The Learning & Teaching Culture Policy outlined herewith is an agreement 
between all students and faculty in the Oklahoma State University School 
of Architecture, and was created in order to assure a positive and healthy 
academic, social and professional environment within the unique culture 
of the School of Architecture. This Policy represents a cultural change and 
conservation agreement, and does not constitute official University policy. The 
basis and power of this Policy lies in action and discussion; it represents a set 
of values and goals, and the actions necessary to achieve them. 

Education

The educational experience of the OSU School of Architecture is as unique and 
rewarding as it is intensive and time-consuming. As such, the Architecture and 
Architectural Engineering curriculums require open and honest communication 
between students and faculty about progress, quality and grades to ensure a 
basis for development and advancement. 

The educational culture of the School of Architecture functions on a balance 
of collaboration and healthy competition. Students and faculty are expected 
to share with and aid others in the process of becoming better designers; 
collaboration not only between students and faculty but also between 
different disciplines serves to create well-rounded students and professionals. 
Simultaneously, competition within the School is used as a tool for motivation 
and advancement, though collaboration and camraderie within competitions is 
welcome and encouraged.

Students are encouraged to learn through exploration of many ideas 
and processes, guided by the experience of their professors. Important 

LEARNING & 
TEACHING CULTURE
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components of design education are learned and taught outside of the design 
studio, and as such it is expected that students and faculty will place equal 
importance on all courses and educational experiences, both inside and outside 
the School of Architecture. It is acknowledged that education outside of the 
School of Architecture both during a student’s college career and after their 
graduation is important, and students and faculty should understand that the 
learning process in a design field never stops.

The students and faculty of the School of Architecture will tolerate no violation 
of the University’s Academic Integrity Policy, including wrongful appropriation 
of a creative work or design.

Health & Wellness

The intensive nature of university education and the curriculum of the School 
of Architecture require that students maintain healthy lifetyle habits to 
succeed. These include healthy sleeping, eating and social habits, as well as 
habits to facilitate overall well-being. The School of Architecture, its faculty 
and its students will continue to place great importance on a healthy lifestyle 
throughout the educational process, and all are expected to spread and teach 
healthy habits while discouraging unhealthy ones. Time management is a 
large part of maintaining healthy habits, and will be taught, encouraged and 
facilitated by faculty and students.

It is well-known that education and life in general can often be overwhelming. 
Support for students will be offered whenever possible and prudent in the 
interest of maintaining physical and mental health. It is also acknowledged 
that education can be financially taxing; students and faculty should strive to 
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◄  Students working in first-year studio 



communicate openly about financial requirements and strain, and whenever 
possible this strain should be minimized so that focus and intention can remain 
on education and learning.

Social Environment

The community of the School of Architecture is of paramount importance to 
the growth and development of students and faculty as individuals and the 
school as a whole. Students and faculty are encouraged and expected not only 
to participate in this community through interpersonal relationships, school 
events, school organizations and other community efforts, but to facilitate its 
maintenance and growth.

In a community as unique and close-knit the School of Architecture, mutual 
respect is the difference between a constructive or toxic culture. No 
disrespect, discrimination or persecution based on any form of diversity will be 
tolerated within the School.

The School of Architecture encourages and facilitates mentorship at 
the student, faculty and professional levels. Healthy relationships with 
knowledgeable mentors is an important part of educational and professional 
development, and while programs are in place for the creation and facilitation 
of mentor-mentee relationships, each student is encouraged to find a mentor 
in their own way. Faculty can serve as knowledgeable and helpful mentors, and 
the School of Architecture prides itself on the close and healthy relationships 
between students and faculty.
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▼  Professor Bilbeisi welcoming Comprehensive Studio 

Physical Environment

As a direct result of the nature of architectural education the design studios 
and other spaces within the School of Architecture are heavily inhabited 
and utilized. In accordance with this usage students are expected to keep 
all spaces within the School as clean as possible, and strive to respect the 
boundaries and space of their peers. Students are free to inhabit and utilize the 
studio in any way, unless this freedom negatively affects those around them or 
the educational goals of the School.

During their time working and creating in the School of Architecture students 
and faculty are expected to be mindful of safety and sustainability. Safe and 
environmentally responsible practices, both for the educational process and 
the profession, will be taught and utilized at the School of Architecture to 
ensure a positive and healthy future for our graduates and for the planet.

Policy

The cultural potential of this policy lies in discussion and action, not in the 
policy itself. With that in mind the policy will be analyzed, rewritten, presented 
and discussed on a regular basis. The governance of this policy can be found 
in the complete version, referenced at the start of this version, as well as the 
endorsement signatures of student leaders and school administration.

Please see your academic advisor for the full version.
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STUDENT 
ORGANIZATIONS

Architectural Engineering 
Institute (AEI)

Open to all students, this national 
organization works as a student 
chapter with the professional 
society of AEI. Our local chapter 
hosts construction site visits, 
licensing exam prep, and travel to 
national conferences.

American Institute of 
Architecture Students (AIAS) 

Open to all students in the School 
of Architecture, this national 
organization provides a voice 
for students to our professional 
organizations. Our local chapter 
hosts academic and social 
activities, as well as travel to 
national conferences for engaged 
members.

Instagram: @osu_aias
Website: aias.org
Email: okstate@aias.org
Faculty Advisor: Jerry Stivers

Instagram: @osuaei
Website: asce.org
Faculty Advisor: Carisa Ramming
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Construction Specification 
Institute (CSI)

Open to all students in majors 
involved in the building 
construction industry, this 
national organization encourages 
collaboration and a better 
understanding of each discipline’s 
role in the profession.

Architecture Students Teaching 
Elementary Kids (ASTEK)

Open to all students, this award-
winning program teaches fifth 
grade elementary students in 
Stillwater basic design concepts 
used in the design of places and 
spaces for people. 

Instagram: @csiokstate
Website: csiresources.org
Email: CSIokstate@gmail.com
Faculty Advisor: Jay Yowell

Email: delcole@okstate.edu
Faculty Advisor: Suzanne Bilbeisi
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We have a plethora of student organizations at the School of Architecture.      
To help you understand the acronyms, here is the who/what of each. 

▲  Annual Pig Roast 
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Freedom By Design (FBD)

This group is an arm of the 
national AIAS, which offers direct 
community engagement through 
design and building. All are 
welcome! 

Instagram: @fbd.okstate
Website: http://www.aias.org/free-
dom-by-design/
Email: fbd.okstate@gmail.com
Faculty Advisor: Jay Yowell

The Almighty S (TAS)

For women (and men) in design. 
Members from Interior Design, 
Graphic Design, Landscape 
Design, Architecture, and 
Architectural Engineering 
may engage in this group that 
seeks to support, empower, and 
celebrate women in all design 
fields.

Twitter: @thealmightys1
Facebook: @thealmightys.okstate
Instagram: @thealmightys.okstate
Email: thealmightys.okstate@gmail.com
Faculty Advisor: Awilda Rodriguez

▼  AIAS members at the Forum in Toronto



Tau Sigma Delta & Chi Epsilon

These are the national honor 
societies for Architecture & 
Landscape Architecture and 
Civil & Architectural Engineering 
students, respectively. Students 
in the top 20% of their entering 
Professional School class are 
invited to join and receive lifetime 
membership.

National Organization of 
Minority Architecture Students 
(NOMAS)

Open to all students, this group 
champions diversity within schools 
of architecture and design and 
fosters fellowship among minority 
architecture students through 
social activities, community 
engagement, and an annual design 
competition and conference.
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Faculty Advisor (TSD): Suzanne Bilbeisi
Faculty Advisor (XE): Mark Krzmarzick

Faculty Advisor: Sarah Ra

In addition to these organizations within our school, there are many other 
opportunities in our college (CEAT) and the broader OSU community. We 
encourage you to get engaged and join an organization!

CEAT’s Diversity & Inclusion Programs provide support to students, including 
those who are historically underrepresented or marginalized. For more info 
on CEAT’s Inclusion & Diversity Plan or programs offered, contact Yokolanda 
Speight: yokolan@okstate.edu.

OSU has over 500 student organizations! For more info check out: 
campuslink.okstate.edu/organizations

▼  Design-build project by Freedom by Design



OSU ARCHITECTURE
AGAIN RANKED IN DESIGN INTELLIGENCE



Each year Design Intelligence prepares a survey of architects asking 
“Which architecture schools do you most admire for a combination of 
faculty, programs, culture, and student preparation for the profession?” Of 
the 82 public undergraduate programs in the United States, OSU ranked 
in the top 20 percent! Graduates of OSU Architecture were also noted as 
among the most desirable to hire. 

Professor Moh Bilbeisi was again named one of the “Most Admired 
Architectural Educators” in the United States. Each year thirty professors 
are identified on this list; with only 2,400 full time faculty of architecture 
this means our Professor Moh is in the top 1% of professors in the 
country!
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OPPORTUNITIES
Scholarships 

CEAT scholarship applications are 
available via the CEAT Scholarships 
website and are due in late January 
each year. While scholarships may 
have specific requirements like 
being limited to Professional School 
students, you cannot be considered 
for a scholarship if you do not 
apply. The OK Board of Governors 
offers scholarships for architecture 
students through the OKC Community 
Foundation. Check those out! Be sure 
to fill out the FAFSA annually to be 
considered for need-based aid.

School Awards

Our school has several special prizes 
or opportunities for recognition 
of students. The top prize is the 
Caudill Fellowship, which is awarded 
to one fifth-year student based 
on an external review of portfolio 
submissions. The Caudill Fellow 
is expected to travel outside the 
boundaries of North America for at 
least one month after graduation. The 
Baumiller Prize is awarded to the top 
project in the Urban Design Studio 
(ARCH 5117). The CEAT Dean’s 
Outstanding Graduate is awarded 
to the all-around top student as 
judged by the faculty of the School 
of Architecture. At the national level, 
the Henry Adams Medal is an honor 
from the national AIA, presented to 
our school’s graduating architecture 
student with the highest GPA. The 
Alpha Rho Chi Medal is a national 

honor presented to the graduating 
student who has distinguished 
themself with meritorious service to 
the school. 

The Pelli Clarke Pelli Preceptorship 
program is designed to allow one 
fourth-year student the opportunity 
to spend 15 months working with 
this world-renowned firm in New 
Haven, CT. The position is paid; 
upon completion of the employment 
term, the student returns to OSU to 
complete degree requirements. The 
Elliott Prize is available for students 
who wish to explore the study of light 
in architecture. 

Each year, the faculty select 
recipients for the Alumni Book 
Awards, presented for excellence in 
design studio work at every level, and 
in advanced studio work for AEs as 
well. Long story short, there are many 
unique awards at the School!

Competitions 

Often our design studios have internal 
sponsored competitions, in which 
students’ work is evaluated by faculty 
and external jurors, with the goal 
of recognizing outstanding work. 
Sponsors include material suppliers 
such as ACME Brick and US Stone, 
and sometimes community groups 
serving as ‘client’ for the studio 
work. Students should view these as 
opportunities to develop their design 
abilities with the potential to receive 
recognition and earn financial prizes 
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along the way. Competition is healthy 
in the design studio, and actually 
mirrors professional practice in which 
work is often “won” in competition with 
other architects.

Mentoring Opportunities 

There are programs available, within 
the school and also with CEAT and 
OSU, to connect with peers and 
professionals for informal mentoring. 
Here at the School, we have the 
AIAS’s Big/Little mentoring program, 
which is designed to help students 
negotiate what it means to be a 
student at the School of Architecture. 

For students in Professional School, 
we offer the Centennial Mentorship 
Program to connect Arch and AE 
students with recent alumni who 
can answer those difficult questions 
surrounding the important transition 
to the profession. Please engage with 
these programs.

Centennial Leadership Development 
Program

Students in Professional School are 
invited to participate in our school’s 
leadership development program and 
receive recognition at graduation 
for their engagement in personal 
development activities. Points are 
awarded in the realms of academic 
excellence, community service, 
expanded worldview, personal 
wellness, and professional readiness. 
Reporting forms are available at the 
front desk, and must be filled out 

before the end of each semester. 
Successful students are recognized 
as “Centennial Fellows” at their 
graduation.

Teaching Assistant Positions 

We offer several opportunities to 
work with faculty and staff as a 
Teaching Assistant in the School of 
Architecture. If you would like to be 
considered for a position, applications 
are due by Friday of Pre-Finals Week 
each semester.

Career Fair

The career fair is organized by 
the AIAS and occurs each spring 
semester, usually in mid-February. 
Here reps from professional firms will 
want to see your resume and talk to 
you about summer internships or full-
time employment opportunities after 
graduation. Be ready with a portfolio 
of your work, and, of course, present 
your best self at the event! 

Computer Specs 

Each year the School of Architecture 
Technology Committee reviews and 
updates the list of hardware and 
software requirements for students in 
the School of Architecture. Generally 
speaking, the most current version 
of software is needed, and many of 
these are available to OSU students 
for free. Check out the IT “Software 
Distribution” page on the OSU 
website. Hardware requirements 
can be found on the School of 
Architecture website.



RESOURCES
Tutoring 

OSU has numerous resources and 
tutoring options available to help you 
succeed. CEAT offers tutoring in all 
levels of math, science, engineering, 
and engineering science courses – 
just for CEAT students. There are two 
locations for CEAT tutoring: the ATRC 
Student Excellence Center and Parker 
Hall basement. Get tutoring help early, 
within the first few weeks of classes, 
and then as often as needed. It will 
make a big difference! Check out the 
CEAT Student Services website for 
tutoring info.

Other OSU resources include:

LASSO Center
Tutoring, Supplemental Instruction 
(SI), & Academic Success Coaching 
021 Classroom Building

Math Learning Success Center 
(MLSC)
Edmon Low Library, 5th floor

Physics tutoring & the OSU Writing 
Center in the Physics Help Room 
Physical Sciences room 052

Mental Health 

OSU has a variety of resources to 
promote mental health. The Walk-in 
Clinic (320 Student Union) is open 
Monday-Thursday, 10am to 3pm 
and is free for students to meet with 
a counselor for a brief session. The 
Reboot Center (320W Student Union) 
offers a space to help calm your mind 
and body, with regular visits from 
Pete’s Pet Posse therapy dogs. Below 
is some helpful contact info. To the 
right are other resources available to 
students.

Additional Contacts:

OSU Police
405-744-6523

OSU Sexual Assault Advocates
405-564-2129

Wings of Hope Crisis Line 
405-624-3020

National Suicide Prevention Lifeline
800-273-8255

Oklahoma Mental Health & 
Substance Abuse Crisis Line
800-566-1343
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Student Counseling Center
320 Student Union
405-744-5458

First four sessions are free, then 
it’s $10 per session. Once you 
complete 12 sessions, it’s $20 
for each additional session.

Alcohol & Substance Abuse 
Center
320 Student Union
405-744-5458

First four sessions are free, then 
it’s $10 per session. Once you 
complete 12 sessions, it’s $20 
for each additional session.

Center for Family Services
101 Human Sciences West
405-744-5058

First four sessions are free, then 
it’s $5 per session.

University Health Services
1202 W. Farm Road
405-744-7665

Medical and psychiatric care. 
Fees vary. Health insurance is 
accepted.

Counseling & Counseling 
Psychology Clinic
111 Public Information Office
405-744-6980

Individual counseling; weekly 
sessions with no overall session 
limit. For students, the first four 
sessions are free, then it’s $10 
per session.

Psychological Services
118 N. Murray Hall
405-744-5975

The initial intake is $10, then 
counseling session fees are 
based off income ($10 minimum).
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Printing

There are several high quality 
copiers and printers available for 
student use at three locations 
within the building: the third 
floor east alcove, and the second 
floor southeast and southwest 
lounges. Some copiers are free, 
other machines provide copies/
prints for a cost per copy/print. 
See posted signs for more info.

Academic Advising

See Ms. Lori Carroll! She can 
supply you with guidance on 
what courses meet degree 
requirements, share some ideas 
for minor areas of study, or just 
provide an ear for listening. She 
can be found in 101 ARCH, or 
reached via email:

Lori.Carroll@okstate.edu

Supplies

The Student Union Bookstore 
carries many supplies you need, 
but Stillwater also has Hobby 
Lobby and Lowe’s. Specialty 
items can also be purchased 
via Amazon. Rhino software 
and some structural manuals/
code books should be purchased 
from the School to obtain the 
discounted rate we receive.
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►  Lori, our academic advisor extraordinaire!



The Print Shop

One side is available 24/7 for 
free prints. The other side is run 
by staff for limited hours each 
week to provide higher quality 
prints. PDFs can be submitted 
via our School of Architecture 
website, and your account will be 
automatically be charged. Please 
allow enough time for the staff to 
accommodate your needs.

RESOURCES
The Cunningham Architecture 
Library

Visit the Architecture Library 
for leisure reading, group work, 
studying, and help finding 
information for your projects. Our 
collection is a valuable asset just 
for you. Library hours:

Monday-Friday  8am-8pm  
Saturday  Closed
Sunday   4pm-8pm
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The Architecture ‘Shops’

We have three shops available 
for student use - the Fabrication 
Shop, the Laser Shop, and the 
Binding Shop. Use is restricted to 
students in Professional School, 
and to those who have received 
training in the equipment. If you 
have questions, talk to Daniel 
Ochoa, our Shop Lab Supervisor.

◄  Daniel and a shop TA using the CNC router
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STUDY ABROAD
The School of Architecture is 
committed to preparing its graduates 
for the professional opportunities 
presented by the expanding global 
economy. As part of this preparation, 
the School requires architecture 
majors to participate in a study-
abroad course of at least four weeks. 
Students study, in an organized and 
disciplined fashion, major examples 
of modern and historic architecture, 
including urban issues in a range of 
places outside the United States. 
Analytic and artistic sketching 
skills, descriptive writing, and other 
forms of observational research and 
record-keeping are important in these 
courses of study.

Alternatively, a student of 
architecture may elect to spend a 
semester abroad, which would meet 
the conditions of the degree plan as 
well. At least a year before a student 
plans to study a semester abroad, 
foreign university program and 
coursework must be coordinated with 
the School of Architecture advisor 
and the OSU Study Abroad Office 
to ensure that courses taken abroad 
meet the requirements of the degree 
plan. 
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◄  (top) Sketching in Rome with Professor Stivers
◄  (bottom) Group at Gyeongbokgung Palace in Seoul
▼  Study Abroad group in Florence
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Studio

is where you are going to live while a 
student in the School of Architecture. 
Check out a desk and move in.

Professional School 

is what we call the upper three years 
of our curricula. It’s kind of a big deal.

Crit 

as in getting a “crit.” means speaking 
with your professor about your design 
project and receiving constructive 
criticism.

Charrette 

as in being “on charrette.” means your 
deadline is fast approaching and you 
are working every minute to meet that 
deadline.

Pin-Up 

is a review of your work in which you 
pin your drawings up on the wall to 
present to a panel of reviewers and 
receive feedback.

Juries 

are formal reviews of your finished 
work. Guests will be invited to review 
the work and comment on it, and you 
will dress better than normal.

Beaux Arts Ball 

is an annual themed costume party for 
the entire school; it is lots of fun!

NEW VOCABULARY
As a student in our school, 
you will likely encounter some 
unfamiliar terms that are part of 
an architecture and architectural 
engineering education here at the 
School of Architecture. Here’s 
a selection of some of the most 
frequently used words:



Pig Roast 

is an annual social event at the School 
of Architecture. It is a decades-long 
tradition and a good time each spring.

ARCH Centre 

is the heart of our school in the center 
on the first floor of the architecture 
building. Get coffee, eat pizza, and 
check out an exhibit here. 

ARE 

(Architect’s Registration Exam) is a 
test that is comprised of several tests; 
after the successful completion of the 
ARE and receiving your license, you 
can call yourself an architect.

AXP 

(Architectural Experience Program) 
provides the framework for 
architecture graduates to document 
internship experience as part of the 
licensure process.

NAAB 

(National Architecture Accrediting 
Board) is the national body that 
accredits architecture degrees. 

NCARB 

(National Council of Architectural 
Registration Boards) is the governing 
body that regulates the licensure 
examination process.

ABET 

(Accreditation Board for Engineering 
and Technology) is the national body 
that accredits AE degrees.   

FE

(Fundamentals of Engineering 
exam) is an exam which should be 
taken before AE students graduate, 
typically in their fourth or fifth year of 
study.

PE / SE 

(Professional Engineer or Structural 
Engineer exam) is the exam which is 
taken after several years of working in 
the AE profession under the guidance 
of a licensed engineer.

Internship 

is when you work for a professional 
firm under the guidance of licensed 
architects or engineers. You must 
always be paid in an internship!

►  Professor Macken in first-year studio
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Customization

Aliases: (Under Tools > Options) 
Allows for personal hotkey 
customization

Keyboard: (Under Tools > Options) 
Allows for one button command(s) 
customization

Mouse: (Under Tools > Options) Can 
change the middle mouse button 
command, among others

2-D Commands

Split: Divides surfaces

Make2D: Get linework

UnrollSrf: Turns volumetric 
geometries into two dimensions

3-D Commands

ExtrudeCrv / Extrude Srf: Two-
dimensional geometry in three 
dimensions

Cap: Closes an open curve or surface

Pipe: Turns a curve into a cylinder

MoveFace: Manipulates edge 
of a geometry (will turn it into a 
polysurface)

ExtractWireframe: Redraws lost 
geometry

Manipulation Commands

Gumball: Gumball transformations 
(Scale, Move, Rotate) can be used 
for free transform and numerical 
transformations

CPlanes: Used for changing primary 
drawing surface

ProjectToCPlane: manipulate 3D 
polylines to 2D

DupBorder: Recall polyline data

Workflow Commands

Hide / Show: Quickly remove and 
reveal geometry, rather than turning 
the layer off

LayerStateManager: Quickly move 
between layers being on or off

Sel / SelectionFilter: quick selections

Tab: Locks to preferred axis

Ctrl + Shift: Select a single face

F6: (Show Camera) Places the camera 
to set a more deliberate view

Named Views: (Under View > Set 
View) Quickly restore set viewports

Fullscreen: Visually removes toolbars

ClippingPlane: Quickly create a 
section view

RHINO TIPS

◄  Students working on a project in studio
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Rhino is the software that students typically use for 3D modeling their projects. 
Rhino is introduced in Design Studio I and used extensively in subsequent 
studios. As students become proficient with Rhino, some learn to use advanced 
Rhino plugins such as Grasshopper and Python. The following are some of the 
most commonly used commands:
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Common

These commands can be used across 
Adobe’s software offerings.

Copy: Ctrl + C

Paste: Ctrl + V

Paste in Place: Ctrl + Alt + Shift + V

Undo Last Action: Ctrl + Z

Zoom In: Ctrl + + (plus)

Zoom Out: Ctrl + - (hyphen) 

Zoom: Alt + Scroll

Zoom w/scroll wheel: Edit > 
Preferences > Tools > toggle Zoom 
with Scroll Wheel

Photoshop

Used for editing raster images and 
photographs.

Brush Tool: B

Eraser Tool: E

Fill: Shift + F5

Fit in View: Ctrl + 0 (zero)

Type Tool: T

Magic Wand Tool: W

Move Tool: V

Rectangular Marquee Tool: M

Indesign

Used to combine text and images for 
creating booklets, posters, etc.

Selection Tool: V or ESC

Direct Selection Tool: A

Preview Mode: W 

Presentation Mode: Shift + W

Text Frame Options: Ctrl + B

Scale proportionally both image and 
image frame: Ctrl + Shift

In Links palette, double-click Warning 
Triangle to update link

Illustrator

Used for editing vector images and 
line drawings.

Selection Tool: V or ESC

Direct Selection Tool: A

Ellipse: L (Hold Shift for Circle)

Line: \

Pen: P

Rectangle: M

Other Adobe software: 

Lightroom is used for organizing and 
editing images across any device and 
Premiere is used for more extensive 
video editing

ADOBE TIPS
Adobe has three different programs primarily used for preparing graphics and 
presentations, which are introduced in Design Studio I and used extensively 
in subsequent studios. The following are some of the most commonly used 
commands:
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Color code your inputs and outputs so 
the table is easy to follow.

Use Excel as your calculator: Type 
“=” and the formula you want Excel to 
solve:   

Ex: “=60*33.4”  

Use IF THEN Excel formulas to make 
everything easier:

Ex: =if(cell 1 > cell 2, then “okay”)

Use dollar signs ($) to keep one cell’s 
formula the same regardless of where 
it moves. Hot key for this is F4

Use the Min / Max command to find 
worst cases from RISA output.  

Ex: Copy output data from RISA 
results and paste in Excel. Type 
“=max” and then highlight all data to 
find largest value

Use Shift + Click and Ctrl + Click to 
highlight more than one box of data in 
most programs.       

EXCEL TIPS
Microsoft Excel can be used for a variety of purposes in architecture and 
engineering. At its simplest level, it can perform basic arithmetic equations 
and create tables. It can also be used to do complicated matrix equations. 
Its most common utilization is probably the creation of spreadsheets to input 
several values, or parameters, and program several equations to be performed 
within the spreadsheet to output a result. This allows students to adjust several 
parametric factors for equation input and quickly see the outcome. Here are a 
few tips/tricks for using Excel:

►  Student working on a project in studio
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RISA TIPS
1. Establish model goals

A common pitfall is the creation of 
analytical models without a clear goal 
in mind. Additionally, most analytical 
models can’t be created in a way to 
solve all issues. So, the engineers 
must establish goals ahead of time 
for what a model is used for. Some 
common examples are:

-  Design of gravity-only members
-  Assessment of member deflection 
-  Extraction of connection forces

2. Investigate solver errors

Often an analytical model will tell 
you when it’s unstable. In addition 
to this warning, it often gives you 
an indication as to which nodes are 
unstable. A few tips:

-  In SAP, make sure you are using 
“standard solver” (not “advanced”) in 
order to return this information
-  In any program, if there are general 
instabilities the program may return 
false clues by spitting back errors on 
random nodes. If you investigate the 
nodes and find nothing wrong, you 
probably have a general instability.
-  Look at which degree of freedom the 
warning message is in. This could be 
another clue.

RISA is a structural analysis 
program, used to track forces and 
design members such as beams and 
columns in a virtual 3D environment. 
Architectural engineering students 
begin working with RISA within the 
curriculum in Professional School. The 
following are some general rules and 
tips for creating an analytical model 
in RISA:

►  RISA model from comprehensive studio
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3. Check fixity and boundary 
conditions

Commonly we consider joints to be 
“fixed” or “pinned” – the software 
treats them the same way. This 
effects how the model behaves 
and where the forces go. As the 
design progresses, we might need 
to reconsider the fixity in members 
if connection conditions change the 
fixity.

4. Check the fundamental period of 
a building

The Fundamental Period, T, is the 
amount of time, in seconds, the 
structure will take to undergo one 
complete cycle of motion if it is 
laterally displaced and released. The 
analysis model will tell you what ‘T’ 
it is calculating for your 3D modeled 
building

Rule of thumb: 1 second per 10 
stories of a building; for example: a 
30-story building will have around a 
3-second period

 

5. Check the deflection under each 
load case

A quick graphic display of deflection 
should show the structure deflected 
a specific direction. This ensures 
you’ve applied your loads in the right 
direction. For example, you’ll see 
a model “sag” under gravity load 
because gravity is always “down”.

6. Check the reactions under each 
load case

You can perform a hand calculation for 
what the total load applied for each 
case is. This should match the sum of 
the load case reactions.



SKETCHES & DOODLES
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▼  How to draw human figures like Moh39

Add the head and feet!

Step 1

Step 2

Step 3

Draw an M for the torso

Draw a W for the legs

Website: https://arch-ceat.okstate.edu/
Facebook: Oklahoma State University 
School of Architecture
Instagram: @OkStateArch
Twitter: @OkStateArch
#okstatearch



QUICK REFERENCE
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Printer/Copier Issues?

Call the front desk, 405-744-
6043, or send an email to 
architecture@okstate.edu 
describing the problem, and 
include the machine number. 
Don’t assume someone else 
already called it in!

Computer Issues?

Can’t connect to the printer? 
Problem with a software license? 
Call CEAT IT at 405-744-1753 
or log-in at https://ceathelp.
okstate.edu and create a help 
ticket.

Deliveries?

To have your food successfully 
delivered to the School of 
Architecture building, be sure to 
use 710 Athletic Ave, 74078. 
Bon appetit!

For mail deliveries, use:
101 DWR Architecture Building
Stillwater, OK 74078

Building Issues?

Problem with card swipe? Leaky 
roof? Plumbing issue? Too hot? 
Call 405-744-6043, or send an 
email to architecture@okstate.
edu describing the problem. Don’t 
assume someone else already 
called it in!

Inclement Weather & 
Campus Safety?

Download the OrangeShield 
app and go from there. The 
Campus Police number is 405-
744-6523. Or call 911 in an 
emergency, of course.
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